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Preface

Audience

Managing Data Using the Oracle Visual Builder Add-in for Excel describes how to work with
Excel workbooks to retrieve and modify a web application's business data and send modified
data back to the application.

Topics:

e Audience

*  Documentation Accessibility

» Diversity and Inclusion

* Related Resources

 Conventions

This document is intended for business users who work with data in Excel workbooks that
integrate with enterprise applications using the Oracle Visual Builder Add-in for Excel.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Diversity and Inclusion

ORACLE

Oracle is fully committed to diversity and inclusion. Oracle respects and values having a
diverse workforce that increases thought leadership and innovation. As part of our initiative to
build a more inclusive culture that positively impacts our employees, customers, and
partners, we are working to remove insensitive terms from our products and documentation.
We are also mindful of the necessity to maintain compatibility with our customers' existing
technologies and the need to ensure continuity of service as Oracle's offerings and industry
standards evolve. Because of these technical constraints, our effort to remove insensitive
terms is ongoing and will take time and external cooperation.


http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs

Preface

Third-Party Content, Products, and Services Disclaimer

This software or hardware and documentation may provide access to or information
about content, products, and services from third parties. Oracle Corporation and its
affiliates are not responsible for and expressly disclaim all warranties of any kind with
respect to third-party content, products, and services unless otherwise set forth in an
applicable agreement between you and Oracle. Oracle Corporation and its affiliates
will not be responsible for any loss, costs, or damages incurred due to your access to
or use of third-party content, products, or services, except as set forth in an applicable
agreement between you and Oracle.

Related Resources

For more information, see the Oracle Visual Builder Add-in for Excel homepage.

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

ORACLE vi
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Introduction to Oracle Visual Builder Add-in
for Excel

Oracle Visual Builder Add-in for Excel integrates Excel spreadsheets with your web
application to retrieve, analyze, and edit business data from the application. You download
your data to an Excel spreadsheet, work with it, then upload your changes back to the
service.

Key Concepts and Terms

Before you use this Excel add-in, it helps to become familiar with these key concepts,
components, and terms.

Term Description

Integrated workbook An Excel workbook configured to work with one or more business objects via REST
services.

Business object A resource - like a purchase order or invoice - that has fields to hold your application's

data. A business object includes a collection path, an item path, a set of fields, and
other properties.

REST service A REST-based web service that provides access to, and operations on, business
objects
Web application A business application that hosts the REST services used by the integration

workbook. Please note that, while "web application" and "REST service" are distinct
concepts, this book uses web application in place of REST service for simplicity.

Layout A way to display a business object in an Excel worksheet. Each worksheet supports
one of two layouts: Table or Form-over-Table. Layouts are created by workbook
developers and are visible to data entry users in their workbooks.

Workbook creator The person or team that integrated a particular workbook with a particular service (or
services). The creator creates layouts, configures workbook behavior, and publishes
the workbook.

Installation

To install the latest version of Oracle Visual Builder Add-in for Excel, download and run the
installer.

You can find the latest version of the installer at the Downloads page on Oracle.com.

For more information, refer to Install Oracle Visual Builder Add-in for Excel.

Next Steps

After you install the Excel add-in, a new Oracle Visual Builder ribbon tab appears in
Microsoft Excel. As a business user who performs data entry, you use the options in this
ribbon tab to download and work with a web application's data exposed in a workbook. You
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Chapter 1
Next Steps

can review, modify, and create data in the workbook, then upload your changes to the
web application.

This image shows a worksheet that manages employees:

File Home Insert Draw Page Layout Formulas Data Review View Help Orade Visual Builder © Tell me [l =
E\E |Seassl E‘I} H [ status Viewer
[E2EEE] [ Network Monitor (i) About
Download Table Row Upload Clear &
Data Changes - Changes [ Log Console Advanced -
Data Show Misc
B15 bt =
A B C D E [F G H |
1 Change Status Email* First Name Last Name® Hire Date Job Title Salary Manager Id
2 Update Succeeded sphren@example.com Sophie Ren 2012-02-09 Manager 65,435.00 101 F
3 Update Succeeded davbro@example.com Dave Brown 2017-07-04 Manager 28,000.00 102 /3
4 Create Succeeded jmcgahern@example.com John McGahern  2018-01-30 Accountant 19,000.00 £
5 Update jnayer@example.com Julie MNayer 2005-07-16 Member Technical staff ~ 3,200.00 120 14
6 sking@example.com Steven King 2003-06-17 Member Technical Staff 24,000.00 100 /3
7 nkochhar@example.com MNeena Kochhar 2003-09-21 Member Technical Staff  17,000.00 100 2

In this example, the user has updated two rows and created a new row with employee
data. These changes have been successfully uploaded to the web application, as
indicated by messages in the Status column. The user has also updated data in
another row that has yet to be uploaded, as indicated by the Update message in the
Change column.
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Install Oracle Visual Builder Add-in for Excel

ORACLE

To install Oracle Visual Builder Add-in for Excel, download the Current User installer (vbafe-
installer-current-user.msi) from the Oracle Downloads page and run the installer.

If any required software is missing, the installation terminates without installing the add-in.
Refer to Software Dependencies in Developing Integrated Spreadsheets Using Oracle Visual
Builder Add-in for Excel for details including information on how to check for and install
required components. You can also refer to this topic for information on installing the
Microsoft Edge WebView2 embedded browser. WebView? is a Microsoft component that
must be installed separately.

This installation is specific to the current Windows user profile. If multiple users on a Windows
machine need the add-in, consider using the All Users installer instead. See Install Using the

All Users Installer in Developing Integrated Spreadsheets Using Oracle Visual Builder Add-in

for Excel.

# Note:

Running both the All Users installer and the Current User installer on the same
machine is not recommended. If you do install the add-in using both installers,
Excel loads the add-in installed in the Program Files folder ("All Users") and not the
version in the current user’'s Windows profile ("Current User"). If you decide to
switch the installation type, the best practice is to uninstall the previous add-in
installation type first to avoid confusion.

To install the add-in:

1. Quit Excel before you begin installation.

2. Double-click the vbafe-installer-current-user.msi file that you downloaded
previously to launch the installation wizard.

3. Toinstall the add-in without the available developer tools, click Developer Options and
select Disabled.

Tip:
If you need these tools after initial installation, re-run the installer, choose the
option to repair your installation, and select Enabled.
4. Click Install to install the add-in.
When the installation is complete, click Close.
5. Start Excel and open a new workbook.

A new Oracle Visual Builder ribbon tab appears with commands that help you download
and manage data from a web application.
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Chapter 2
Check for Updates

File Home Insert Draw Page Layout Formulas Data Review View Help Oracle Visual Builder

[ Network Monitor @About
O Log Consale #._ Advanced -

Data Show Misc

When you first run Excel after the current-user installation, you may be prompted
to confirm the installation of the "Office customization”. This prompt generally
appears the first time for each profile and whenever the digital certificate (used to
sign the add-in) is changed.

Check for Updates

ORACLE

Oracle Visual Builder Add-in for Excel automatically checks for updates once per Excel
session when the first integrated workbook is opened. If there is an update available,
you are prompted to upgrade.You can also check for a newer version of the add-in
using the Check for Updates command available from the Advanced menu. If there
is a newer version, you can get the latest version of the add-in from the Downloads
page.

If prompted to upgrade, you can choose to get the latest version right away or instead
skip the upgrade.

= Check for Updates x

© A newer version is available. Do you wish to go get it? Click Go to open a browser to
the add-in installer download page.

Upgrade tips:

- Upload or discard any pending changes prior to upgrade
- Quit/exit Excel completely before running the installer

- Clear your layouts after upgrade

Remind me | Next Session = Go Skip

Mext Session
Mext Week

If you choose to skip an upgrade, you'll be reminded again based on the duration you
set in the Remind me list. If you select "Next Session", you'll be prompted to upgrade
when you next launch Excel and open an integrated workbook.

To check for an update manually:

1. From the Advanced menu in your existing installation, select Check for Updates.
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Chapter 2
Upgrade to the Latest Version

<J Logout
(i) About
Workbook |nfo...
Edit Service Host...
Manage Translations...
Reset Styles
Edit Workbook Parameters...

Clear List of Values Cache

Check for Updates
Select Language...
Log Activity...
Diagnostic Report...

Clear Browser Cache

If a newer version is available, when prompted to open the downloads page in your
browser, click Go.

Download the installer for the latest version, then install the update. Before you update,
be sure to review best practices as described in the previous section.

Upgrade to the Latest Version

To take advantage of all the latest Oracle Visual Builder Add-in for Excel features, make sure
you are running an up-to-date version of the add-in. To upgrade to a new version, simply
download and run the installer.

ORACLE

For recommendations on when you should upgrade, check the Upgrade Policy in Developing
Integrated Spreadsheets Using Oracle Visual Builder Add-in for Excel.

You do not need to uninstall the previous version unless the installer instructs you to do so.

To ensure a clean upgrade, follow these instructions when upgrading your installation.

1.

Before you upgrade the add-in:
a. Upload any pending changes using the current add-in version.
b. Save changes in open workbooks, then close Excel.

Run the installer for the new version and follow the instructions in the wizard. The
installer automatically replaces the previous version with the new version.

After you upgrade:
a. Launch Excel to complete any final installation steps.

b. Open your integrated workbook.
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Chapter 2
Upgrade to the Latest Version

c. Clear any layouts of old data and download data again as required.
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Manage Data in Table Layouts

In Microsoft Excel, select the Oracle Visual Builder tab to perform operations and work with
data in a workbook.

When you open an integrated workbook for the first time, you may be prompted to redraw all
layouts if the workbook was published in a different language. If you choose to redraw the
workbook, any data and changes to the layouts are discarded. To keep these changes, skip
the redraw. You can always manually redraw your workbook later using either the Clear
Layout or Download Data icons from the Oracle Visual Builder tab.

# Note:

Clearing all layouts when the language changes is recommended since some data,
such as lists of values, may be language sensitive. Downloading in one language
and uploading in a different language may not succeed.

File Home Insert Draw Page Layout Formulas Data Review View Help Oracle Visual Builder £ Tell me whal
P— e &

E{li :4? Status Viewer j Logout

— = [ Network Manitor (i) About

Download Table Row Upload Clear

Data  Changes - Changes [ Log Console ¥, Advanced -
Data Show Misc

N15 b 2

A E C D E F G H | 1
1 Change Status Email* First Name Last Name* Hire Date Job Title Salary Managerld Department* K
2 sphren@example.com Sophia Ren 2012-02-08 Manager 65,435.00 101 Research
3 davbro@example.com Dave Brown 2017-07-04 Member Technical Staff 28,000.00 102 Accounting
" Jsieve@example.com John Sieve 2012-05-11 Member Technical Staff  76,543.00 102 Accounting
5 jnayer@example.com Julia MNayer 2005-07-16 Member Technical staff ~ 3,200.00 120 Accounting
= sking@example.com Steven King 2003-06-17 Member Technical staff 24,000.00 100 Accounting

For any given layout, you can:
*  View existing rows

« Edit existing rows

*  Create new rows

* Delete existing rows

» Perform actions on existing rows, for example, an "Approve" or "Reject" action for an
Invoice business object. These kind of special actions can be performed on certain
business objects depending on the context. For more information, see Perform Actions in
a Table or Form-over-Table Layout.
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Chapter 3
General Guidelines

< Note:

Capabilities described in this guide may not be available for all integrated
workbooks. A workbook's functionality depends on how it was configured
and the capabilities that the web application provides.

If your operation requires access to the web application, a Service Configuration
window prompts you to enter the service host value. Ask your IT administrator for the
correct value to provide here. Operations that require access to the web application
include the Download Data and Upload Changes commands.

(= Service Configuration x

OK Cancel

# Note:

You can also access the Service Configuration window using Edit Service
Host from the Advanced drop-down list.

General Guidelines

ORACLE

When working with data in the Excel workbook, remember the following guidelines:

* Never edit the Key column, the last column in the table.

* Avoid using the following Excel features with Oracle Visual Builder Add-in for
Excel. The following is a sample list of Excel features that do not work well with the
add-in. Other Excel features not listed may also not work well with the add-in.

— Do not use the Protect Sheet or Protect Workbook features of Excel.
— Do not attempt to re-arrange the layout of the integrated worksheet.

— Do not use the Mark as Final command to make the Excel workbook read-
only.

— Do not save your workbook to the Excel 97-2003 workbook (. XLS) file format.
Only the .xXLsx and .XLsM file formats are supported.

— Do not delete anything from the integrated worksheet using Excel's delete
features, including the Delete key.
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Chapter 3
Download Data to the Workbook

— Do not add Excel tables, such as those created from the Excel ribbon using Insert >
Table, to an integrated workbook. These table objects are incompatible with the table
layouts used by the add-in.

* You can use Excel's Filter and Sort features to filter and sort rows in a table layout with
this proviso: Be sure to include the Key column in the range to be sorted when using the
Sort feature. Failure to do so could lead to corrupted data.

* Do not attempt to modify the Change column directly. Instead, follow the procedures
described in this section.

You can remove all data from the workbook, including any pending changes that have not yet
been uploaded to the web application by clicking the Clear button.

Download Data to the Workbook

ORACLE

Download data to the workbook using the Download Data button in the Oracle Visual Builder

tab. The workbook prompts you for a user name and password the first time you connect to
the web application.

If search options were configured for download, specify the value(s) to search on, as shown
in the following example where data for the Sales department will be downloaded:

& Search — (] X

uals Sales X

Clear Values  OK | Cancel

< Note:

Required search fields are marked with an asterisk (*). You must provide values for
these fields before you can proceed.

If the search returns lots of rows, confirm if you want to continue downloading more rows:

&

Already downloaded 499 rows. There are more rows available. Please choose one of
the following options.

Download All Stop Now

T "

When download is complete, the add-in updates the table in the worksheet with data
retrieved from the web application.

A B C D E i G H | J K L e

Status - %
4 Change Status Id* First Name Last Name* Email* Phone # Hire Date Job Title Salary Manager Id Department*
¥ Notifications
il @ X + 5 .
2 147 John McGahem  jmcgahern@example.com +15195550113  1/30/2018 Accountant 19,000.00 Accounting Table downlosd complated
3 7 Steven King sking@example.com +15195550136  6/17/2003 Member Technical Staff 24,000.00 100 Accounting successfully.
4 8Neena  Kochhar  nkochhar@examplecom +15195550138 9/21/2005 Member Technical Staff 17,000.00 100 Accounting Bovnioaded | 6itable rove:
Elapsed time: 00:00:02
5 9 Lex DeHaan  Idehaan@examplecom  +15195550142  1/13/2001 Member Technical Staff 17,000.00 102 Accounting
5 3 Dave Brown davbro@example.com  +15195550132  7/4/2017 Manager 28,000.00 102 Accounting
7 50 Nancy Greenberg  ngreenbe@example.com  +1519 5550133 8/17/2002 Member Technical Staff 12,008.00 108 Research
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Chapter 3
Edit Downloaded Data in the Workbook

Edit Downloaded Data in the Workbook

ORACLE

Edit data downloaded to a workbook by modifying editable cells that contain the
downloaded data.

The following image shows three examples where a user has edited data in the table.
The Change column for the first row displays an Update message that indicates the
user has updated this row with required and valid values. The Change column for the
second row also displays an Update message, but its Status column displays an
Invalid message and a red border appears around the Hire Date* column’s cell to
indicate that a value is required in that cell’s field. Finally, in the third row, the user
attempted to input Software in the field for Department. As Software is not a valid
choice for this cell's list of values, a red border appears around this cell.

A B C D E F G H | J K L M I
1 Change Status Id* First Name Last Name*  Email* Phone # Hire Date* Job Title* Salary Commission % Managerld  Department Ki
2 Update 100 John King SKING 6/17/2003 12:00 AM Finance Manager 24,000.00 Executive
3 |Update Invalid 101 Neena Kochhar  NKOCHHAR I:l;dmwstratmn Vice President 100 Human Resources -
4 Update Invalid 102 Lex De Haan LDEHAAN 515.123.4569 1/13/2001 12:00 AM Finance Manager 7,000.00 'DD""”

If a cell has a date format, you can enter a date by selecting the cell and choosing a
date from the date picker pop-up window.

1/22/2021
4 January 2021 >

Su Mo Tu We Th Fr Sa
27 28 29 30 31 1 2
3 4 5 6 7 8 9
10 11 12 13 14 15 16
17 18 19 20 21 23
24 25 26 27 28 29 30
31 1 2 3 4 5 6

¢ Note:

The date picker only sets the date in a date-time field. The time value is not
changed.

If columns have an associated list of values, you can select a value in a search-and-
select window. In this case, the Change column displays Update. Alternatively, enter
one or more of the starting characters for other values, then click the Search icon to
filter the values based on your input. The following composite image illustrates both
these scenarios. For the latter scenario, the user entered s in the search box next to
the Search icon to find all display values that start with s (Sales Manager, Sales
Representative, and so on).
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Chapter 3
Create New Rows to Upload to the Web Application

Finance Manager

| ] | ]

Job Title® Job Title®

Finance Manager Finance Manager
o, g o ||°

President 5ales Manager
Administration Vice Presid Sales Representative
Administration Assistant Stock Manager
Finance Manager Stock Clerk
Accountant Shipping Clerk

Accounting Manager
Public Accountant
5ales Manager

5ales Representative

Purchasing Manager

¢ Note:

Remember that Excel table objects, such as those created from the Excel ribbon
using Insert > Table, are incompatible with the table layouts used by the add-in. For
more information about Excel feature compatibility, see General Guidelines.

Create New Rows to Upload to the Web Application

Create new rows in the table using the Insert Rows option in the add-in's Table Row
Changes menu or by using Excel options to insert a full row.

You can create new rows before or after downloading data to your workbook:

* To create new rows in a table with downloaded data, click Table Row Changes and
select Insert Rows, or right-click and choose Insert from the Excel context menu (you
can choose any Excel option to insert a row). You can create new rows either at the end
of the data table or in the middle.
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Chapter 3
Create New Rows to Upload to the Web Application

Q Tip:

To insert multiple rows, select cells from multiple rows, then select Table
Row Changes > Insert Rows. The add-in will create multiple pending
Create rows for you to fill out as needed, as shown here:

A B | C D E F G H I

1 Change Status Id* First Name Last Name® Email® Phone # Hire Date® Job Title® Sz
P 100 Steven King SKING 515.123.4567 6/17/2003 12:00 AM President 244
3 Create 209 John Jones JJONES 6/6/2019 12:00 AM Accountant 12¢
4 | Create Invalid

5 | Create Invalid o -
G 101 Neena Kochhar ~ NKOCHHAR 515.123.4568 9/21/2005 12:00 AM [Job Title* ent 17t
= 102 Lex De Haan  LDEHAAN  515.123.4569 1/13/2001 12:00 aM | © A value is required. Jent 17
s 103 Alexander  Hunold ~ AHUNOLD  590.423.4567 1/3/2006 1200 v __er @ value o

e To create several new rows without downloading data, if create is enabled for the
Table, add values in the empty row that appears below the column headers. This
empty row is known as the placeholder row:

A B C D E F G H | J K

] Change|5tatus First Name Last Name* Email* Hire Date Job Title Salary Manager Id Department® Key

Once you enter data in the placeholder row (for example, in the cell for First
Name), the add-in automatically recognizes the row as a pending Create row. To
insert more rows, select a cell in the first row after the table and select Table Row
Changes > Insert Rows.

File Home Insert Draw Page Layout Formulas Data Review View Help Orac
E\E e aaaal E 5 e [ status Viewer
[2222] - ] Network Monitor (i) About
Download Table Row Upload Clear
Data Changes~ Changes [ Log Console % Advanced -
I—|— Insert Rows I Show Misc

7] Mark as Changed

'@ Mark for Delete

e E F G H | ] K
- &> Unmark Pending Changes

1 |Change swatus rirst vame vastwame® Email® Hire Date Job Title Salary Manager Id Department® Key

o | Create Invalid John | | |:|

3

Any time a new row is created, it is validated for data entry. An Invalid message
appears in the Status column if the row contains a cell where you are required to enter
a value and have yet to do so. A red border also appears around the cell where a
value is required or invalid. See Understanding Data Validation.
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Chapter 3
Understanding Data Validation

WARNING:

Never insert partial rows into a table layout as this can lead to data corruption. Also,
never use the Excel Insert option to shift cells down or to the right.

Understanding Data Validation

As you enter values in cells associated with layouts, Oracle Visual Builder Add-in for Excel
validates the cell's content based on the business object field definition as well as any custom
validation rules that are defined.

R B e D E F G H | -
Proposed Salary Status - *
(Adiust Salary)

65,900

1 Change  Status Email* First Name Last Name* Hire Date Job Title Salary

¥ Notifications

> |Adjust Salary sphren@example.com Sophia Ren 2012-02-09 Manager 65,435.00

3 Update Invalid davbro@example.com Dave Brown 2017-07-04|Research 28,000.00

| Pending create.

¥ Selected row status

4 Create Invalid | |

Data entry errors found.
5 Email hn Sieve 2012-05-11 Member Technical Staff  76,543.00
& Q A value is required. lia Nayer 2005-07-16 Member Technical Staff ~ 3,200.00

5 Enter a value. aven King 2003-06-17 Member Technical Staff  24,000.00

Validation occurs when you complete data entry in a cell; in other words, as soon as you
enter or edit a value in a cell and move on to another cell or area. Validation also occurs at
other key points:

*  When a new row is added to the data table
*  When the Create Form Row option is selected from the Form Changes menu

» At the beginning of an upload.

Typically, the add-in determines whether a cell's value is consistent with the expected data
type. For example, you can't enter a word, say, book, in a field that expects a number like
2,000. It also checks whether a required cell is missing a value and whether the value in a
cell associated with a list of values is valid for that list. Required fields are designated by the
workbook developer and must include a value for your changes to be uploaded successfully.

Your workbook may also include some custom field validation rules that restrict the value you
can enter into a cell. For example, you may have an Expense Reports workbook where the
expense amount must be less than $500.00. As with other data validation errors, a cell with
an invalid value (in this case, a value of $500 or more) is marked with a red border. You can
select this cell to view a popup that provides a description of the error.

Understanding Read-Only Behavior

ORACLE

If a particular field is considered read-only, the add-in behaves as follows:

* It applies a "read-only" style to the corresponding cells to indicate that the value cannot
be changed

e The cell's value is excluded from any subsequent upload to the web application
e The data entered by the user is not validated

* If the workbook is published with worksheet protection enabled, any attempt to edit the
cell results in a warning from Excel:
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| The cell or chartyou're trving to change is on a protected sheet. To make a change, unprotect the sheet. You might be requested to enter a passward,

K

Delete Data from the Web Application

Mark rows for deletion from the web application using the Mark for Delete option in
the Table Row Changes menu.

Caution:

Do not attempt to delete rows from your worksheet using Excel commands
such as Delete Cells or Delete Sheet Rows. Doing so will not remove the
row from the web application.

To mark a row for deletion from the service:

1. Select a cell in the table row that you want to delete from the web application. If
you want to select a range of table rows to mark for deletion, hold down your
keyboard’s Shift key and select the first and last row in the range of table rows that
you want to delete.

2. Click the Table Row Changes menu, then Mark for Delete.
A Delete message appears in the Change column and the add-in changes the
style applied to the data in the table rows, as shown in the following image where
three rows in the table are marked for deletion:

A B C D E F G H 1 J K L M N |
1 |Change Status Id* First Name LastName™  Email* Phone # Hire Date* Job Title* Salary Commission % Managerld Department Key
o 205 Shelley Higgins SHIGGINS ~ 515.1238080 6/7/2002 12:00 AM Accounting Manager 1200800 101 Accounting
= 206 William Gietz WGIETZ 515.1238181 6/7/2002 12:00 AM Public Accountant 8.300.00 205 Accounting
Lo/ Delete 209 Bobby Dooley BDOOLEY 6/6/2019 12:00 AM Accountant 12,000.00
|10| Delete 210 James Jones JJONES 6/6/2019 12:00 AM Accounting Manager 14,000.00
Delete 211 John Evans JEVANS 6/6/2019 12:00 AM Public Accountant 12,000.00

111

3. Click Upload Changes.

4. When prompted to confirm pending deletions, click Yes.
The add-in sends delete requests for each row that you marked for deletion. For
each successful deletion, the corresponding Excel row is removed. If the deletion
fails, the Excel row remains with an error message.

A B | C D E F G H 1 J K L M N |
1 Change Status Id* First Name Last Name*  Email* Phone # Hire Date* Job Title* Salary Commission % Managerld  Department Key
o 205 Shelley Higgins SHIGGINS ~ 515.123.8080 6/7/2002 12:00 AM Accounting Manager 12,008.00 101 Accounting
- 206 William Gietz WGIETZ 515.123.8181 6/7/2002 12:00 AM Public Accountant 8.300.00 205 Accounting

109
110

111
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Tip:

If you change your mind about deleting one or more rows that you have marked for
deletion, select the rows and select Unmark Pending Changes from the Table

Row Changes menu. Use Unmark Pending Changes before you upload changes
from the Excel workbook; the option does not work after the changes are uploaded.

Manage Attachments

ORACLE

If your integrated workbook has an attachments table layout, you can upload and download
attachments as well as perform standard create, edit, and delete functions.

Attachments are often associated with a parent business object. For example, an expense
report may have one or more associated attachments representing receipts. For this reason,
attachment table layouts are often a child layout in a hierarchy of layouts in a workbook. In
our example, a form in a Form-over-Table may display the expense report header and the
child table may list the associated attachments. Keep in mind that the attachment table could
be located on a separate worksheet from its parent layout. See Manage Data in Form-over-
Table Layouts and Manage Data for Multi-Level Business Objects.

Oracle Visual Builder Add-in for Excel supports attachments of file, text, and web page types.
Unknown attachment types are treated as file type attachments.

Upload Attachments

You can add URLSs, as well as text and file type attachments, to attachment records and
upload them to the web application.

To upload a new or revised file or text attachment:

1. Select any field in a new or existing row to open the Attachment pop-up window.

2. From the pop-up window, click the Upload icon.
Change Status Type File Name url Title Description Local File Path
TEXT attachment.txt Text attachment Text attachment
WEB_PAGE httpsi//link/to/documenthtml Web page attachment Web page attachment

FILE receipt pdf PDF attachment PDF receipt attachment

Create
ack t

< Note:

The Upload icon is disabled when you select a field in a new row if Create is
not enabled for the table layout. It is also disabled for an existing row if Update
is not enabled.

3. From the Choose a File to Attach dialog, navigate to the location where the file is
saved.

4. Select the file and click Open.
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Chapter 3
Manage Attachments

The local file path is displayed in the read-only Local File Path column. A link also
appears in the pop-up. You can use this link to open the local file in the file's
default program.

File Name Url Tit
attachment-file.pdf Example file

k

Attachment
ype File t

File name attachment-file.pdf

Local file Clattachments\attachment-file. .+, T,

For new files, specify the attachment type in the Type field.

The add-in recognizes FILE, TEXT, and WEB_PAGE as valid values for this column
to represent file, text, and web page type attachments respectively. These values
are case sensitive.

The Change column for the row displays a Create or Update message. The
attachment is now pending upload.

Click Upload Changes to upload the attachment.

To add or edit the URL for a web page:

1.
2.

3.

Type the URL directly into the Url field for a new or existing row.

For new URLs, type WEB_PAGE in the Type field.
The Attachment pop-up window is read-only in this case and provides a link for
the current URL.

Url

Text atta

http://www.oracle.com/index.html Web pa¢

pe Web page

URL hitp://www.oracle.com/index.html

Click Upload Changes to upload the URL.

During upload:

The attachment records are processed first without any attachment files. The
upload of attachment records occurs just like any other table upload.

For each successful row that has a pending file upload, the add-in attempts to
upload the file. If the file can't be found or read at the location in the Local File
Path column, an error is reported for that row. If the upload of the given
attachment record fails, the corresponding file upload is skipped.

If the attachment record is marked for delete, any pending file change is ignored at
upload time.
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* If you don't upload changes from the layout, the new attachments are never sent to the
service.

Download Attachments
To download an attachment:

1. Select any field in a row with a file or text attachment to open the Attachment pop-up
window.

2. From the pop-up window, click the Download icon to download a local copy of the
attachment.
Change Status Type File Name Url Title Description Local File Path
TEXT attachment.txt Text attachment Text attachment

WEB_PAGE https://link/to/documenthtml Web page attachment 'Web page attachment

FILE receipt.pdf PDF attachment PDF receipt attachment

3. Inthe Save Attachment dialog, navigate to where you want to save the file and click
Save.
After successful download, a link is provided in the attachment dialog to open the file in
the default program.

Limitations

*  The only supported attachment types are file, text, and web page. Unknown attachment
types are treated as file type attachments. The values for the attachment type file to
specify each type are "FILE", "TEXT", and "WEB_PAGE" respectively. These values are
case sensitive.

* The Ul may appear to freeze during download for large attachment files.

* Manually editing the file path in the Local File Path column is not supported. Use the
Attachment pop-up to specify the local file location.

* For some services, create may fail for text-based attachments. Ensuring all required
attachment fields, such as the Title, are present and resubmitting the record generally
resolves this issue.

Upload Changes to the Web Application

Once you make all the changes that you want to make, you are almost ready to upload all
your changes to the web application.

Review the Change column in your layout. You'll see a message for each row marked for
change: Create for new rows, Update for changed rows, and Delete for rows marked for
deletion. If you have performed an action on a row, the Change cell for the row will indicate
the action to be performed (such as Approve for an expense report) on the next upload.
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Upload Changes to the Web Application

Tip:

If you change your mind about a pending change, select the row, then select
Unmark Pending Changes from the Table Row Changes menu. Oracle
Visual Builder Add-in for Excel won't include the row when it sends other
rows back to the service for update, creation, or deletion.

When you are ready, click the Upload Changes button from the Oracle Visual Builder
Add-in for Excel tab. The add-in performs all the requested operations, as indicated in
the Change column. When the upload has completed, the add-in displays an Upload
completed message in the Status Viewer and status messages for each processed
row in the Status column of the table.

A B C D E F G H -
Status “ &

¥ Notifications

4 |Change Status Id* First Name Last Name*  Email* Phone # Hire Date* Job

202 Pat Fay PFAY 8/17/2005 12:00 AM Marketing Repre
104
Upload completed.
105 203 Susan Mavris SMAVRIS 6/7/2002 12:00 AM Human Resourc
Create rows: 1 succeeded, 1 failed, 2 total

204 Hermann Baer HBAER 6/7/2002 12:00 AM Public Relations

106 Elapsed time: less than one second

205 Shelley Higgins SHIGGINS 6/7/2002 12:00 AM Accounting Man
L ¥ Selected row status
108 Create Succeeded 207 John Jones JJONES 6/6/2019 12:00 AM Administration v Create Failed
109| Create Create Failed | 208 Jenny Jones JEJONES I:lsales Manager O A value is required for column: Hire Date™
]
206 william Gietz WGIETZ 5151238181 6/7/2002 12:00 AM Public Accountar

110

Review the Status column to see which rows succeeded and failed. You might see
status messages such as Create Succeeded, Update Failed, Delete Failed, and
Skipped. Skipped means that a row marked for update had no changes and was not
included in the upload.

In this example, the Status column displays a Create Failed message in the cell of a
row that the add-in failed to create. You can review the Selected Row Status in the
Status Viewer for additional information on the failure. Here, a required value for Hire
Date was not entered. Enter a hire date and click Upload Changes to try and upload
the modified data again.

Successfully deleted rows are removed from the Excel worksheet while failed attempts
to delete a row result in the row remaining in the Excel worksheet. You can inspect the
reason for the failure to delete in the status in the Status Viewer.

Some web applications may issue warning messages for successfully uploaded rows.

The message in the Status column contains an indication that there were one or more

warnings for that row. Select a row with a warning icon to display details of the warning
in the Status Viewer.
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L B =

4 |Change Status Expense Report |d*
5 Update Succeeded Oracl
& Update Sucoeided Oracl
7 Create Succeeded tnp b
g Create Succeeded 0
g Update Succeeded /& Oracl
10 succeeded: Reject
1 Succeeded: Reject N
i3 | Reject Failed: Reject
12 Succesded: Repect 1

# Note:

Following a successful upload, you may see a message like this: "This row may not
contain the latest information from the service. Download to refresh the information
for this row." If you see this message, click Download Data to refresh your
workbook with the latest data from the web application.

In some cases, your workbook may be configured to upload all changes to a parent row and
its descendent rows (child rows, grandchild rows, and so on) in a single request. If this is the
case for your workbook, then the add-in can only successfully upload your changes if there
are no errors in any of the rows.

If there are one or more errors in the set of changed rows, all the rows are marked as failed.
To troubleshoot the error, review the errors in the Status Viewer for each form, table, and
descendant table in your workbook. Once you've fixed the errors in the pending changes, you
can retry the upload operation.

# Note:

You may have to fix and retry the upload more than once before it succeeds. The
REST service may not report all errors that occur during a single upload operation.

Clear Cache for a List of Values

Some fields may have associated choice lists, called lists of values. The choices for each
list of values are stored locally (cached) in the workbook.

In some cases, the cached choices for a list of values may become stale or out of date. To
start fresh with the latest values, select Clear List of Values Cache from the Advanced
menu.
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Data Consistency

The add-in helps prevent multiple users from overwriting each other's changes.

ORACLE

Consider this scenario:

1.

Person A downloads information from a business object into a table in their
integrated workbook.

Person B downloads the same information into a table in their integrated
workbook, edits it, and uploads changes.

Person A then edits the same information (downloaded in Step 1) and uploads the
changes.

The add-in provides the service with the necessary information to prevent Person
A's changes from overwriting those changes made by Person B. Instead, when the
server detects such a change, its response allows the add-in to display an error
message similar to the following for any such rows in the table:

This row has been modified by another user. Please download before editing.

If you see this message, you'll have to discard your changes by downloading the
latest data and then redoing your changes as needed.

< Note:

Some services do not support this conflict detection functionality. If the
service does not, then Person A's changes will replace Person B's changes
with no warning. Contact the service owner for more information.
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Manage Data in Form-over-Table Layouts

In addition to Table layouts, an Excel workbook can use a Form-over-Table layout, when a
parent-child relationship exists in the business objects used by your web application. In this
case, you can manage the parent object's data as part of a form and the child object's data in
a table, both of which are available in a single worksheet.

View and Edit Data in a Form-over-Table Layout

Viewing and editing data in a Form-over-Table layout is similar in many ways to viewing and
editing data in a Table layout.

For example, you use the Download Data button to download data from the Form-over-Table
layout’s business objects. Much like Table layouts, you may be prompted to do a search at
the beginning of a download. Unlike a Table layout, however, the Form-over-Table displays
the first row found from the search, plus all the children of that first parent row.

In some cases, you may be able to update the form fields in a Form-over-Table. The add-in
performs data entry validation when you create a form row or update a field. Ensure that you
fix any data entry errors before you attempt to upload your changes.

For a form field configured to use a list of values, the behavior is the same as described for
the Table layout. That is, a search-and-select window appears when you select the form field.
Read-only form fields cannot be edited (see Understanding Read-Only Behavior).

When you are ready to upload the changes you made, click Upload Changes. Once the
upload is complete, review the notifications in the Status Viewer to see if any operations
failed. For more information about error messages and troubleshooting, see Upload Changes
to the Web Application.

Create a Parent Row in a Form-over-Table Layout

If create is enabled for the form, you can select Create Form Row in the Form Changes
menu to place the Form-over-Table layout in create mode. When you first click Create Form
Row, all the form fields are blank and the child table has no rows, as shown here:
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Delete a Parent Row in a Form-over-Table Layout

File Home Insert Draw Page Layout Formulas Data Review View Help Oracle Visual Build O Tell me 1 =
LA " ) 5
E\E sl E‘l} @ Status Viewer J Logout
. < | [ Network Monitor | (1) About
Download Table Row Upload Clear
Data Changes = Changes [J Log Console #. Advanced ~
Data Show Misc -
Al v fe || Employees v
A B C D E -
v x
' il ¥ Notifications
o | First Name Last Name* I:l
3 Email I:l Hire Date ¥ Form
4 Job Title Salary Pending create.
5 Manager Id Department* I:l Data entry errors found.
6
7
8 Change Status Dept Number* Dept Name  Location Key
9

You can then enter form field values, even create new child table rows. All changes
are marked as a pending create, until you click Upload Changes. The add-in validates
the data before it attempts to upload updates; you must fix any data entry failures
before the changes can be uploaded. If the upload of the form fails (applies to both
Create and Update changes), the upload of the child table is skipped.

A . B . C D
Employees
First Name Last Name* Doe
Email* johndoe@example.com Hire Date
Job Title Salary
Manager Id Department*  Accounting
Change Status Dept Number*  Dept Name

Create Succeeded

80|Commumcat|ons

L

Status

¥ Notifications

Form upload completed.

Form row created successfully.

Table upload completed.

Create rows: 1 succeeded, 0 failed, 1 total.
Elapsed time: less than one second

¥ Form

Create Succeeded

¥ Selected row status

Create Succeeded

Delete a Parent Row in a Form-over-Table Layout

If delete is enabled for the form, you can use the Delete Form Row option in the Form
Changes menu to delete the parent row in a Form-over-Table layout.

1. Click Download Data to download data from the layout’s business objects.

2. |If search is configured, search for the desired record.

3. Inthe Form Changes menu, select Delete Form Row.

ORACLE
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Delete a Parent Row in a Form-over-Table Layout

File Home
-]

—1H

_n.gl; -=

Download  Form

Data Changes~ Changes =~ Changes

Insert Draw Page Layout Formulas Data Review View Help

|z=z=z] = @ Status Viewer
1 I "
] Metwork Monitor

[ -
Bt el .
Table Row Upload Clear
[] Log Console

o Logout

(i) About

#_ Advanced ~

—+  Create Form Row Show Misc
e

Al fe || Employees

]ﬁ[ Delete Form Row

A ] 5] | C | D | E | F |
] Empluyee.ls
5 First Name Dave Last Name* Brown
3 Email* davbro@example.com Hire Date  2017-07-04
4 Job Title Member Technical Staff Salary 28,000.00
5 Manager Id 102 Department* Accounting
6 |
?_
g Change Status Dept Number* Dept Name Location Key
g 10 Accounting India =

You can only delete an existing form row (not a pending Create row).

When prompted to

confirm the form row delete, click Yes.

Once you confirm, the form row is immediately deleted (unlike a Mark for Delete action in
a table that takes effect only during an upload).

Click OK.

After the form row is deleted, your layout is cleared of data; the Status Viewer also
indicates that no form row exists.

ORACLE"
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Perform Actions in a Table or Form-over-Table

Layout

In addition to data entry operations such as edit, create, and delete described previously,
some web applications define special operations, "custom actions", on business objects.
These actions can be defined on individual rows from a business object or on an entire
business object.

Let's take an example of a expense reports layout in a workbook. The web application may
have a number of actions defined for this business object. Some of these actions are
performed on individual expense reports, such as "Approve" and "Reject".

Other actions are performed on the entire business object. For example, you may have two
actions on your expense reports layout, "Send to Auditor" and "Escalate Overdue Reports".
The first one identifies all expense reports that are not in compliance and forwards them to an
auditor. The second one prompts you to provide the number of days overdue and then sends
an email to the assigned approver for each matching expense report.

Perform an Action on a Row

ORACLE

To perform an action on a single row, select the row in either the form or table of a layout,
then use the appropriate command from the Form Changes (Perform Action) or Table Row
Changes (Mark for Action) menu.

For tables, you can also update a cell in the action columns as you would any other field's cell
value. In the following Table layout, rows marked as Reject are those where the user has
updated cell values corresponding to the Reason (Reject) and Notes (Reject) action columns.

A B C D E F G H |
] Change Status Expense Reportld®*  Reporter® Justification Approver ld Reason™ (Reject) Notes (Reject) Rpt Status

Reject 15,001 Steven King Conference Other: contact approver  Details with manager Pending

Reject 006 David Austin Conference Missing receipt Pending
4 Reject 15,011 John Chen Site visit Exceeds budget guideline Pending
5,016 Alexander Khoo Oracle Open World Pending

6 15,021 Matthew Weiss Oracle Open World Pending

When you add or update a value in an action cell first, the row is marked for that action in the
Change column. Other cells in that row that don't involve actions are grayed out and cannot
be edited. But if you add or update a value first in a cell that doesn't involve an action, the row
is marked as an Update in the Change column and the action cells in that row are grayed out
(as shown in the following image). In other words, the first change you make to a row
determines what kind of pending change is applied to that row. See also Understanding
Read-Only Behavior.
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A B € D E F G H |
;| |Change Status Expense ReportId®  Reporter® Justification Approver Id Reason*® (Reject) Notes (Reject) Rpt Status
5 | Reject 15,001 Steven King Conference Other: contact approver  Details with manager Pending
3 | Reject 15,006 David Austin Conference Missing receipt Pending
4 | Rejedt 15,011 John Chen Site visit Exceeds budget guideline Pending
5 Update 15,016 Alexander Khoo Site visit Pending
6 15,021 Matthew Weiss  Oracle Open Waorld Pending

You can also mark rows for an action by selecting Mark for Action from the Table
Row Changes menu. With this option, if only one action is defined, you'll be prompted
to confirm. If more than one is defined, you'll be prompted to select from a list of
available actions:

File Home Insert Draw Page Layout Formulas Data Review View Help Oracle Visual Builder

1A | zzzzal :41\ @ : | ~ Status Viewer l Logout
- HiH - o

v Network Monitor l_, About
Download | Table Row | Upload Clear Perform c
Data  |Changes ¥ Changes Action Log Console Advanced ¥
4 Insert Rows Show Mise
A4 '+ Mark as Changed
A [E Mark for Delete D E F G H |
1 Changl &) Mark for Action.. [;\ IRegion' Purpose Final Approval Date Reporter Id* Approver Id Status Id
. ) Oracle Open World )
2 Rejec &' Unmark Pending Changes forthEast ){} 15 Steven Pending
3 |APPIOVE | & Choose an action to perform on the selected rows = O X Submitted
4 . Approved
Filter
5 Br Paid
Title Description .
6 Rejected
Reject Rejects the selected expense report(s) for the reason provided.
7 Pending
Approve Approves the selected expense report(s); Optional notes may be supplied.
8 Submittec
9 Approved
10 Rejected
1 oK Cancel ik
12 - ———T3UTT INOTIICUST OrEte UPET VYOI ZUTS - Jonm Pending
13 15012 NorthEast Oracle Open World 2015 Ismael Submittec
Audit Exp. Reports ® 1
Ready

When a row is marked for an action, the action's fields also receive the same
validation, as described in Understanding Data Validation.

The actions for these marked rows are performed during the next upload.

If you're working with a Form-over-Table layout, select Perform Action in the Form
Changes menu, then follow the prompts in the wizard to perform an action on a Form
row.
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File Home Insert Draw Page Layout Formulas Data Review View Help Oracle Visual Builder

s Designer ﬁ =\Il} :g E:';:-!m :y{l\ @ FI v| Status Viewer < Logout
- - (e ] 3

llj Delete Layout +| Network Monitor "‘-" About
[j 4 Publish | Download| Form | Table Row Upload Clear Perform =

& Manage Catalogs Data Changes ¥ Changes v Changes Action Log Console #, Advanced v
Design ~+ Create Form Row Show Mec
c6 : Jr I eI bectorm amnng IJS MARITAL_STATUS
B [i] Delete Form Row D E F G H

5 ExpenseReports
| & Perform action on ExpenseReports - O X
4 | Expense Report id* 15,001

Choose an action to perform on the form row

5 Purpose Oracle Op|
Title Description
6 Reporter Id* |Steven M4
Reject Rejects the selected expense report(s) for the reason provided.
7 Partition Id* NorthEast|
s Approve Approves the selected expense report(s); Optional notes may be supplied.
|
9
10 Change # End D:
1 00 5/10/202(
12 00 5/10/2021
13 :00 5/10/202(
14 :00 5/10/202(
15 Cancel Back Next || Finish F0013/10/2021
SEETEVRECN A TR A LAMEANEL A LA I A0 B £ 00
Expense Report Review ® 4
Ready

An action can be performed only on an existing form row (not on a pending Create row).

An action on a form is performed immediately, unlike one in a table (where rows are marked
for actions and the actions are performed later during an upload). For best results, use
Upload Changes to submit any changes in the table first, then Perform Action on the form
row.

After uploading (for table rows) or performing an action (for the form), any result from the
action returned by your web application is displayed in the Status Viewer. For example, after
invoking the action "Reject" on an Expense Report table row, the Status Viewer shows a
confirmation code as the result:

Status EE
¥ Naotifications
Table upload completed.

ws: 1 suce

v Selected row status
Succeeded: Reject

he action ks: Your confirmation

Also, form row data is not automatically refreshed after an action is performed, even if the
action was successful. Click Download Data again to refresh data in the form row.
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Perform an Action on a Business Object

Perform a business object action using the Perform Action button on the Oracle
Visual Builder ribbon. This button launches a wizard that prompts you to select the
action and provide values for any required parameters.

ORACLE"

The action is performed at the scope of the entire business object. It may act on some,
all, or none of the items in the business object. In particular, there may be no
relationship between the items affected and those items (rows) displayed in the layout.

1.

Open the layout for the business object with the defined action.

If there are one or more business object actions defined, Oracle Visual Builder
Add-in for Excel displays the Perform Action button on the Oracle Visual Builder
ribbon.

File Home Insert Draw Page Layout Formulas Data Review View Help Oracle Visual Builder
- |35zz1] ""{I’\ @ . | Status Viewer
- -] : :
o Network Monitor (1) About
Download Table Row Upload Clear Perform -
Data Changes ¥ Changes Action Log Console Advanced ~
Data Show Misc
\J
# Note:

If you do not see the Perform Action button, this means that the
business object associated with the current layout does not have any
defined actions.

Click Perform Action to launch the Perform Action wizard.

(=) Perform action on ExpenseReports - O X

Choose an action to perform on ExpenseReports
Title Description

Finds all expense reports that do not comply with the corporate

Send To Auditor )
guidelines and forwards them to an auditor for review.

Finds all expense reports that are overdue for submission by a

Escalate Overdue Reports  given number of days and sends an email to the assigned
approver.

Cancel Back Next Finish

Select the required action from the list, then click Next.
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Perform an Action on a Business Object

&2 Perform action on ExpenseReports - ] b4

Action

Provide a value for each action field and click the Next button to perform the action:  Clear
Days Overdue

5

Cancel Back Next Finish

If required, provide values for each action field, then click Next to perform the action.

&2 Perform action on ExpenseReports - ] b4

Action Results

Action

Description

Qutcome
The business object action succeeded.

Result: Found 30 expense reports overdue by 5 or more days, sent notifications to
approvers

Cancel Back Next

The final screen of the wizard shows the results of the action.

Click Finish to close the wizard.

ORACLE"
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Manage Data for Multi-Level Business
Objects

Sometimes business objects exist in a multi-level hierarchy. For example, a purchase order

(PO) might contain a header and a set of lines. Each of these lines may contain one or more
schedules and so on. For these hierarchies, Oracle Visual Builder Add-in for Excel supports
operations across all "dependent” layouts.

In this example, purchaseOrders is referred to as the "parent" business object, lines is the
“child", and schedules is the "grandchild". A workbook based on this hierarchy might use a
Form-over-Table layout or a Table layout as the top-level, or "primary”, layout.

If the workbook uses a Form-over-Table as the primary layout, the form displays the parent
business object and the table, the child business object. If the workbook uses a Table as the
primary layout, the table displays the parent business object.

In this diagram, a Form-over-Table layout on Sheet 1 displays the details of a purchase order
in the form and all associated lines for this purchase order in the table. An additional
dependent Table layout on Sheet 2 displays all the schedules associated with the PO's lines.

Sheet 1 Sheet 2
Purchase Order Schedule A
Schedule B

-
@ Schedule C
\E/ Schedule D

Schedule E
Line 1 Schedule F
Line 2
Line3

If, instead, the workbook uses a Table layout as the primary layout, then each level in the
hierarchy has its own Table layout on a separate worksheet. In this diagram, Sheet 1 includes
a Table layout for the parent business object showing the details for three purchase orders.
Sheet 2 and Sheet 3 includes dependent Table layouts for the child and grandchild business
objects, respectively.
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Sheet 1 Sheet 2 Sheet 3
Purchase Order Lines Schedules
[ PO 1 PO 1, Line 1 | PO1,Line 1, Schedule A |
PO 2 PO 1, Line 2 PO 1, Line 1, Schedule B
\ PO3 PO1, Line 3 PO 1, Line 2, Schedule A
. PO 2, Line 1 PO 2, Line 1, Schedule A
PO 2, Line 2 PO 2, Line 1, Schedule B
PO 3, Line 1 PO 2, Line 2, Schedule A

PO 2, Line 2, Schedule B

PO 3, Line 1, Schedule A

PO'3 Line 1, Schedule B |

Chapter 6

Each of these dependent layouts is linked to its direct parent layout. Check the Status

Viewer for a given Table layout's parent.

Status

¥ MNotifications

Table download completed successfully.

Downloaded 18 table rows.

Elapsed time: less than one second

¥ Parent

Schedules

When you click Download Data, Upload Changes, or Clear for a layout in a

dependent hierarchy, the operation takes effect on all layouts in the hierarchy, starting
with the primary layout, progressing to the next layout in the hierarchy, and continuing
down until the last level in the hierarchy. When the operation is complete on all layouts

in the hierarchy, the worksheet with the primary layout is made active again.

ORACLE
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Download Data

During a download operation, the add-in downloads matching items for each layout in the
hierarchy, starting with the primary layout, progressing to the next layout in the hierarchy, and
continuing down until the last level in the hierarchy.

Take the scenario where there are four layouts: a primary Form-over-Table layout for
purchaseOrders (parent) and Lines (child), and three dependent Table layouts for
Schedules (grandchild), Attachments (grandchild), and Distributions (great-grandchild).
Following a download, you would see that the first worksheet with the primary layout displays
the purchase order in the form that matches the query and all associated child lines (say,
three Lines) that match a configured query (if applicable) in the table.

The second worksheet displays all child schedules associated with the downloaded lines
again based on any configured query. If each of the three Lines had three matching child
Schedules, the Schedules table would download 9 schedules. And so on for the other
worksheets. You can then update all of these lines, schedules, distributions, and attachments
and upload all the changes together.

Once the download is complete, the Status Viewer displays any notifications including how
many rows were downloaded at each level, as shown in this example:

Status R
¥ Notifications

Form download completed successfully.
Downloaded form row.

Table download completed successfully.
Downloaded 3 table rows.

Elapsed time: less than one second
Dependent layouts’ download status
Schedules: Downloaded 9 rows.
Distributions: Downloaded 18 rows.
Attachments: Downloaded 0 rows.

¥ Form
Mo changes pending.

Following a download, edit data much as you would in a Table or a Form-over-Table layout.
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< Note:

If you do not see all of the expected rows in your dependent layouts, check
with your workbook developer. These layouts may have been configured with
a search parameter that limits the rows that are downloaded.

Create New Rows

Create new rows on the primary layout as you would for any Form-over-Table layout or
Table layout. See Create a Parent Row in a Form-over-Table Layout and Create New
Rows to Upload to the Web Application.

For Table layouts below the primary layout, you need to associate new rows with the
appropriate parent when you create them. For example, you'll need to specify the
correct line for a new schedule and the correct schedule for a new distribution.

To ensure you can properly associate new rows with the correct parent, the layout may
include one or more columns from the parent layout. For example, the distribution
layout may contain columns for Schedule Id from the schedule layout.

So, when you create a new row in the Distributions table, you'll need to enter valid
values in the parent column (Schedule Id, in our example) to ensure the new
distribution is associated with the right schedule.

As soon as you do so, the add-in populates any other ancestor columns, such as Line
Id and Line Description, with the correct values. If the entered schedule value doesn't
match an existing schedule, the add-in does not populate the other ancestor columns.

You must enter non-empty values in the parent columns that uniquely identify an item
in the parent table. If, during upload, the entered schedule value doesn't match an
existing schedule, creation of the row fails.

You can't enter values for grandparent and higher columns. These fields are read-only.

Upload Data

When updates are ready to be uploaded, the upload operation submits all pending
changes across the hierarchy of layouts. Pending changes may include creation of
new items, deletion and updating of existing items, and invocation of actions on items,
depending on how the layouts are configured and what capabilities are supported by
the business objects.

You can view details of the operation in the primary layout's Status Viewer, which
shows results for the primary layout as well as a summary for each layout in the
dependent hierarchy, as shown in this example:
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Status MR

¥ Notifications

Form upload completed.
Form row updated successfully.
Table upload completed.
Update rows: 1 succeeded, 0 failed, 1 total.
Elapsed time: less than one second
Dependent layouts’ upload status
Schedules: All rows uploaded successfully.
Distributions: All rows uploaded successfully.
Attachments: Mo rows are marked for update,
create, or delete.
¥ Form

Update Succeeded

W Selected row status

Update Succeeded

Click each dependent layout to view additional details of the operation.

In some cases, your workbook may be configured to upload all changes to a parent row and
its descendent rows (child rows, grandchild rows, and so on) in a single request. If this is the
case for your workbook, then the add-in can only successfully upload your changes if there
are no errors in any of the rows.

If there are one or more errors in the set of changed rows, all the rows are marked as failed.
To troubleshoot the error, review the errors in the Status Viewer for each form, table, and
descendant table in your workbook. Once you've fixed the errors in the pending changes, you
can retry the upload operation.

# Note:

You may have to fix and retry the upload more than once before it succeeds. The
REST service may not report all errors that occur during a single upload operation.
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Troubleshoot Excel Workbooks

If you experience issues with Oracle Visual Builder Add-in for Excel, follow the steps here to
identify and resolve issues. If you still can't resolve your issue, contact Oracle Support.

* Review the documentation to make sure the desired operation is supported.
* Download and run the Client Health Check Tool.

e Make sure you're on a supported platform.

e Upgrade to the latest version of the add-in.

e Apply available Microsoft updates.

e Close all workbooks, exit Excel, and try again with simple steps.

* Forissues with the workbook, contact the workbook creator.

e Generate an add-in log for review. See Logging. If you contact Oracle Support, you may
be asked to provide this log.

e If you are having an issue with a login page, try clearing the browser cache. See Clear
the Embedded Browser Cache.

» If some Oracle Visual Builder ribbon commands are disabled after you open a
workbook, check the Workbook Info window for details on the issue. See Resolve
Workbook Issues.

Check Your Environment

ORACLE

Run the Client Health Check Tool to check if the desktop configuration and environment are
suitable for Oracle Visual Builder Add-in for Excel and to resolve issues.

Download the latest version of the Client Health Check tool (vbafe-health-check.exe)
from the Oracle Downloads page.

1. Run vbafe-health-check.exe and review the result for each examined item.
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2.
3.

Chapter 7

Apply Microsoft Updates

X

(= Client Health Check - Oracle Visual Builder Add-in for Excel

This tool examines your machine to determine whether Oracle Visual Builder Add+n for Excel is installed and properdy
configured.

tem Resut  Comment
Microsoft NET Framework @ installed
Microsoft Edge Web\View2 Runtime | @ | installed
Visual Studia 2010 Toals for Office Runtime | @ |installed
Microsoft Excel | @ |installed
Oracle Visual Buider Addn for Excel installed status @  [nstaled

Oracle Visual Builder Add-in for Excel is cumently disabled. it must be re-enabled in order to use integrated workbooks.
See https.//docs microsoft com/en-us/visualstudio /vsto /howtore-enable-a-vsto-add-anthat-has-been-disabled,

Cick the "Fix Problems” bution to solve this problem.

| Ex Problems N Befresh Save Repot As...
"y

ORACLE’
Copyright ® 1957, 2022, Oracle and/or its affilates. Al ights reserved

Select each failed item (@) for more details, including the steps necessary to
resolve the issue. If the add-in can resolve the issue, the Fix Problems button is

enabled.

# Note:

The Client Health Check tool may also show warnings (£) if it finds
something that is not optimal. You don't have to resolve warnings in
order to use the add-in but it is recommended. Select each item with a
warning to display information on how to resolve the warning.

Click Fix Problems if available or follow the instructions to resolve the issue.

If Oracle Support requests a copy of the report:

a. click Save Report As... and choose a name and location for the report.

b. Review the report and remove any sensitive information.

c. Send the report to Oracle Support.

Apply Microsoft Updates

ORACLE"

When troubleshooting issues with Oracle Visual Builder Add-in for Excel, we
recommend first applying all pending updates for Windows and Excel before

reproducing the issue. A Microsoft patch may resolve your problem.

1.

From the Windows Start menu, select Settings, Update & Security, and then

Windows Update.

If updates are available on the Windows Update page, review the updates and

click Install Now.
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< Note:

Chapter 7
Re-Enable Oracle Visual Builder Add-in for Excel

The details of applying Windows updates can vary from version to version and
also according to your company's IT policy. Check with your system
administrator for assistance, if needed.

Re-Enable Oracle Visual Builder Add-in for Excel

If your add-in becomes disabled and you are unable to use the client health check tool, you
can re-enable Oracle Visual Builder Add-in for Excel through Microsoft Excel.

ORACLE

Restart Excel.

CAE S

In Excel, click File > Options > Add-Ins.

Select COM Add-ins in the Manage drop-down list and click Go.

Deselect the Oracle Visual Builder Add-in for Excel check box and click OK.

Enable the add-in by repeating the steps and instead selecting the Oracle Visual

Builder Add-in for Excel check box from the Add-ins available list in the COM Add-ins

dialog.
Excel Options

General

Formulas

Proofing

Save

Language

Advanced

Customize Ribbon
Quick Access Toolbar
Add-ins

Trust Center

D View and manage Microsoft Office Add-ins.

Add-ins
Mame

Oracle Content Add-In for Office
Oracle Visual Builder Add-in for Excel

sis ToolPak

Analysis ToolPak - VBA

Euro Currency Tools

Microsoft Actions Pane 3

Microsoft Power Map for Excel

Oracle ADF Desktop Integration 12c Ad
Oracle Beehive Add-In for Office

Send to Bluetooth

Solver Add-in

Add-in: Oracle Content Add-

Publisher:
Compatibility: Mo compatibility infd

Oracle America, Inc.

(7 el

Location Type -

Chation\office'\x86\ OfficeAddindll - COM Add-in
C\...vbes-excel-addin.vstolvstolocal  COM Add-in
Excel Add-in
Excel Add-in
Excel Add-in

XML Expansion Pack

COM Add-ins

Add-ins available:

:‘ Microsoft Power Map for Excel

:‘ Oracle ADF Desktop Integration 12¢c Add-In for Excel

:‘ COracle Beehive Add-In for Office

|| Oracle Content Add-In for Office

Pl Oracle Visual Builder Add-in for Excel
nd to Bluetooth

Location:

C:\Users\-n‘\ppData\Roaming\Ora cle\COracle Visual Builder At
Load Behavior: Load at Startup |

Location: C\Program Files (x8
Description: Oracle Content Adg
Manage: | Excel Add-ins H’

Excel Add-ins

COM Add-ins k

Actions

0K Cancel

XML Expansion Packs

Disabled ltems
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Chapter 7
Logging

When reporting an issue about the add-in, generate a detailed log file that captures the
steps that lead to the problem you want to report.

The log file that you generate captures information about steps during an Excel

session.

1. In Excel, click the Oracle Visual Builder tab.

2. Select Log Activity from the Advanced menu to specify a directory location and
file name for the log file. This starts the logging session.

3. Repeat the steps that lead to the issue.

4. Exit Excel completely to stop the logging session and before you access the log

file.

¢ Note:

The next time you run Excel logging will no longer be enabled.

Caution:

Log files may include personal information from the user's computer
including, but not limited to, the computer's name and the end user's
Windows profile name. Be sure to select the appropriate option when
uploading files with personal information to a service request so that file
access can be restricted as needed.

Clear the Embedded Browser Cache

Oracle Visual Builder Add-in for Excel uses an embedded web browser to display web
pages from inside Microsoft Excel. If required, you can clear the cache for the
embedded browser to get rid of all browser data including profile data such as history,
bookmarks, and cookies.

To clear the cache for the embedded browser, choose Clear Embedded Browser
Cache from the Advanced menu.

ORACLE
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Clear the Embedded Browser Cache

L | Logout
(i) About
# Advanced ~

Workbook |nfo...
Edit Service Host...

Manage Translations...

Reset Styles
Edit Workbook Parameters...

Clear List of Values Cache

Check for Updates
Select Language...
Log Activity...
Diagnostic Report...

Clear Browser Cache I} Clear Embedded Browser Cache

Clear all browsing history from the
embedded browser used by the
add-in.

Oracle Visual Builder Add-in for Excel uses the WebView?2 control as an embedded browser if
it detects a compatible version of the WebView2 runtime. Otherwise, it uses the .NET
WebBrowser control, which is based on Microsoft Internet Explorer (IE).

If the add-in uses the WebView?2 control as the embedded browser, the cache is cleared. If it
uses the .NET WebBrowser control instead, you'll see this message:

er Cache |

| @ To clear the embedded browser cache, open Windows Settings then search for
Internet Options and use the Delete button to delete the browsing history.

OK

Close this message and clear the browser cache as directed.
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Resolve Workbook Issues

Resolve Workbook Issues

If you see an error message when you open a workbook or find that some Oracle
Visual Builder ribbon commands are disabled, Oracle Visual Builder Add-in for Excel
has detected an issue with your workbook. Use the Workbook Info window to
troubleshoot these issues.

Your workbook may be unusable for a number of reasons such as if it is marked as
final in Excel or has been saved to an incompatible file type.

To check the status of your workbook, open the Workbook Info viewer by choosing
Workbook Info from the Advanced menu of the Oracle Visual Builder ribbon. This
viewer shows information such as the name, location, and status of your workbook.

& Workbook Info — O x

Information about the active workbook

Done | |

Check the status for the description of the issue and for any troubleshooting steps.
Issue-free workbooks have a status of "Integrated”. Workbooks that are not integrated
with the add-in will show a status of "Not integrated".

In a scenario where a workbook is marked as "final", you'll need to clear the Mark as
Final setting (under File>Info>Protect Workbook), then save and reopen the
workbook.

# Note:

Do not use Excel's Edit Anyway button in the yellow message bar to try to
edit the workbook. This command will not re-enable the Oracle Visual
Builder ribbon.
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Manage Language and Culture

You can change the display language for Oracle Visual Builder Add-in for Excel to any one of
over 30 supported languages. If the workbook has been localized into your language, the
add-in also displays your workbook's field titles and so on in the selected language.

When you open an integrated workbook for the first time, you may be prompted to redraw all
layouts if the workbook was published in a different language. To keep these changes, skip
the redraw. You can always manually redraw your workbook later using either the Clear
Layout or Download Data icons from the Oracle Visual Builder tab.

If you choose to redraw the workbook, any data and changes to the layouts are discarded.

< Note:

Clearing all layouts when the language changes is recommended since some data,
such as lists of values, may be language sensitive. Downloading in one language
and uploading in a different language may not succeed.

Change the Add-in's Language

By default, Oracle Visual Builder Add-in for Excel automatically detects the user's preferred
language from Microsoft Excel and uses that language where possible. If desired, you can
change the language that the Excel add-in uses.

To change the add-in language:
1. In Excel, click the Oracle Visual Builder tab.

2. Choose Select Language from the Advanced menu.

3. From the Add-in Language list that appears, select the language you want to use. The
list displays the languages that the add-in supports.

4. Click OK.
5. Clear the embedded browser cache. See Clear the Embedded Browser Cache.
6. Restart Excel to make your changes take effect.

The add-in's user interface elements (Download Data and so on) now use the language you
selected. If the preferred language uses a right-to-left writing system, the add-in's windows
appear in right-to-left mode.
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Change the Add-in's Language

< Note:

Changing the add-in's language does not affect the format of the data in the
cells. Data formats are determined by your Windows region settings. See
Excel or Windows options to change Excel's language and formats for dates,
times, and numbers. See also Natural Language Support in Developing
Integrated Spreadsheets Using Oracle Visual Builder Add-in for Excel.

If the workbook has been localized for the preferred language, the add-in uses that
localization as well.

The language that you choose for the add-in language is stored in a local file in the
Windows user profile. You can select the Use Excel’s Language Setting option in the
Add-in Language drop-down list to remove this setting for the current user.

View Help Oracle Visual Builder

<J Logout

(i) About

% Advanced ~

& Add-in Language >

Choose a Preferred Language (7]

Add-in Language '9

English - English - en -

Use Excel’s Language Setting (E a -
Arabic - duywll - ar
Chinese (Simplified) - 3 (E{%) - zh-Hans

= Chinese (Traditional) - £ 3 (5£88) - zh-Hant =

Croatian - hrvatski - hr

Czech - ¢e&tina - cs
Danish - dansk - da
Dutch - Nederlands - nl
English - English - en
Estonian - sesti - et
Finnish - suomi - fi
French - frangais - fr
French (Canada) - frangais (Canada) - fr-CA
German - Deutsch - de
Greek - EAAnikG - el
Hebrew - nMay - he
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